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ANEXO PRÁCTICAS 
 

1.- Introducción a PROTEL99. 
 
Protel junto con Orcad constituyen las dos empresas de software de CAD electrónico más 

importantes en entorno PC.  
 
Protel es un sistema de diseño completo para entornos Windows y proporciona un 

conjunto de herramientas integradas formadas por un gestor de documentos integrado, un 
capturador de esquemáticos, un simulador analógico basado en SPICE, un simulador digital 
basado en CUPL (lenguaje similar a ORCAD/PLD), una herramienta de diseño de placas de 
circuito impreso (PCBs) y soporte para trabajo en redes de ordenadores, además de algunas cosas 
más. 

 
Orcad también proporciona otro entorno similar ORCAD v9.0. Básicamente todos estos 

programas funcionan de forma similar, por lo que estudiar uno de ellos será suficiente. 
 

1.1.- Conceptos Básicos 
 
Una vez comenzamos a utilizar el programa podemos distinguir las siguientes partes de la 

pantalla, que se observan en la imagen siguiente. 
 

 
 

1- Gestor de Diseño. Este panel muestra el árbol de navegación similar al Explorador de 
Windows, nos ofrece una vista de las bases de datos de diseño que tenemos abiertas y los 
documentos que contienen. Haciendo clic en los iconos + y – podemos expandir y contraer 
las carpetas. Haciendo clic en un documento o carpeta podemos abrirlo o verlo en la ventana 
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de diseño principal. Si hacemos clic con el botón derecho en un documento o carpeta aparece 
un menú de opciones. También se muestran en el panel del gestor de diseño paneles de 
edición específicos que aparecen como pestañas cuando se editan varios tipos de 
documentos. 

2- Estaciones de diseño activas. Haciendo clic en el símbolo + podemos ver una lista de 
ordenadores de la red que están ejecutando Protel. 

3- Equipo de diseño. Esta es una carpeta especial dentro de cada base de datos de diseño que 
nos permite configurar y mostrar información sobre las propiedades de compartición del 
diseño. 

4- Ventana de diseño. Cada base de datos de diseño abierta dispone de una ventana de diseño 
asociada empleada para mostrar documentos de diseño abiertos y carpetas. 

5- Pestañas de diseño. Los documentos abiertos y las carpetas aparecen como pestañas en la 
ventana de diseño. Haciendo clic en una pestaña hace a ese documento o carpeta activa. Al 
hacer clic con el botón derecho sobre la pestaña aparece un menú de opciones, incluyendo la 
posibilidad de dividir la ventana para mostrar varias pestañas al mismo tiempo. 

6- Menú del Explorador de diseño. Haciendo clic en la flecha de la esquina izquierda de la 
barra de menús activa el menú del Explorador, que ofrece varias opciones del sistema. 

7- Asistente de ayuda. Haciendo clic en este icono nos ofrece ayuda simplemente tecleando la 
pregunta. Existe un sistema de análisis de preguntas en lenguaje natural (naturalmente en 
Inglés) que presenta una lista de temas de ayuda relacionados. 

 
 

1.2.- Combinaciones de teclas útiles. 
 
Las siguientes combinaciones de teclas se pueden usar para navegar por el Explorador de 

diseño: 
CTRL-TAB Circula a través de los documentos abiertos en la ventana de diseño. 
CTRL-F4 Cierra el documento activo en la ventana de diseño. 

 
Cuando se trabaja en un esquemático o en una PCB en Protel, se pueden emplear las 

siguientes teclas para cambiar la vista: 
 
V, D  Para ver el documento entero. 
V, F  Zoom para encajar todos los objetos del documento. 
RePág  Zoom para acercar centrado en la posición del cursor. 
AvPág  Zoom para alejar centrado en la posición del cursor. 
Fin  Redibuja la pantalla 
Esc  Termina la acción en proceso 

 
Usar los siguientes controles de ratón sobre objetos en el esquemático o PCB: 
 

Clic-sencillo Enfoca un objeto. Aparece el cursor de edición, permitiéndonos cambiar la 
forma del objeto. 

Clic-mayúsculas Selecciona o deselecciona un objeto. Los objetos seleccionados pueden 
cortarse, copiarse, borrarse, etc. Clic-mayúsculas es acumulativo, se 
pueden seleccionar varios objetos, para deseleccionarlos todos pulsar X, A. 

Doble-Clic Abre el dialogo de propiedades del objeto para su modificación. 
Clic-botón derecho Termina la acción en proceso 
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1.3.- Los cursores de edición. 
 

Cuando activas cualquier proceso en Protel sobre un objeto o documento, el cursor 
cambia a una cruz para permitir un posicionado preciso. En general, una vez que se ha entrado en 
modo edición permanecemos en este modo hasta que hagamos un clic con el botón derecho o 
pulsemos Escape para volver al cursor normal de Windows. Esto nos permite repetir acciones 
como la colocación de múltiples objetos, sin tener que volver a lanzar el proceso. 

 
Además, con Protel se puede mientras se esta 

realizando una determinada tarea realizar otra tarea, para 
luego volver a la primera, como por ejemplo durante una 
colocación de componentes se puede cambiar el zoom para 
luego seguir colocándolo. 
 
1.4.- Obtención de ayuda (ojo, en Inglés). 
 

El sistema de ayuda en lenguaje natural nos permite 
realizar preguntas en Inglés sencillo obteniendo una lista de 
temas de ayuda apropiados. También se puede pulsar F1 en 
cualquier momento para obtener ayuda de una determinada 
opción o menú en el que nos encontremos. 

 
Además disponemos de ayuda del tipo “Qué es esto”, 

que consiste en una pequeña marca de interrogación 
colocada en el borde superior derecho que al pulsar ofrece una explicación somera del 
control donde nos encontremos. Pulsar en cualquier sitio para quitarla. 

 
2.- Gestión de documentos con Protel 99. 

 
2.1- Apertura y trabajo con una base de datos de diseño. 

 
Protel 99 incluye ficheros de diseño de ejemplo que se pueden encontrar en la carpeta 

C:\Mis Documentos\Design Explorer 99\Examples. Para examinar algunas de las características 
de Protel, abrir el fichero de ejemplo Photoplotter: 

 
1. Seleccionar File -> Open de los menús y navegar hasta 

la carpeta de ejemplos. 
2. Hacer clic en la lista de ficheros sobre Photoplotter.ddb 

y luego sobre el botón Open. El diseño se abrirá y se 
mostrará en el árbol de navegación. 

3. Hacer clic en el símbolo + al lado del nombre del diseño 
en el árbol de navegación para expandir la carpeta y 
mostrar su contenido. 

4. Hacer clic en el símbolo + para expandir la carpeta 
Electronics, y luego Photohead. Esta carpeta contiene 
la placa PCB, lista de componentes y esquemáticos para 
una cabeza de fotoploter. 

5. Hacer clic en el fichero Photohead.pcb en el árbol de 
navegación. La placa PCB se abrirá en la ventana de 
diseño. 
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6. Hacer clic en Photohead.prj. El esquemático de más alto nivel para el circuito se abrirá. Se 
puede cambiar entre los documentos abiertos haciendo clic en las pestañas de la parte 
superior de la ventana de diseño. 

7. Continuar explorando el diseño de ejemplo. Para cerrar un documento abierto, hacer clic con 
el botón derecho en la pestaña correspondiente de la ventana de diseño y seleccionar Cerrar 
del menú emergente (teclado CTRL-F4). Para cerrar el diseño entero y eliminarlo del árbol 
de navegación, seleccionar File -> Close Design de los menús. 

 
2.2.- Presentación de múltiples documentos simultáneamente 

 
1. Abrir el diseño anterior.  
2. Hacer clic sobre el símbolo + al lado 

del nombre del diseño en el árbol de 
navegación para expandir la carpeta, y 
luego expandir las carpetas 
Electronics y Photohead. Hacer clic 
en el icono Photohead Parts List 
para abrir el documento en la ventana 
de diseño. Hacer lo mismo con 
Photohead.pcb y Photohead.prj. 

3. Hacer clic con el botón derecho del 
ratón en la pestaña Photohead Parts 
List en la ventana de diseño y 
seleccionar Split Horizontal del 
menú emergente. La ventana de 
diseño se partirá en dos, mostrando la 
lista de componentes del diseño en la 
mitad inferior y los documentos 
abiertos en la otra. 

4. Hacer clic en la pestaña photohead.prj en la ventana de diseño y seleccionar Split Vertical 
del menú emergente. La ventana de diseño se divide de nuevo. Ahora podemos ver los tres 
documentos simultáneamente. Se puede mover el borde de la división moviendo el ratón 
sobre el eje de división hasta que el cursor cambie a una flecha doble. Hacer clic y arrastrar 
para mover el eje de división. 

5. Para eliminar la división de la ventana, hacer clic con el botón derecho sobre cualquier 
pestaña de la ventana de diseño y seleccionar Merge All del menú emergente. 

 
2.3.- Creación de una nueva base de datos de diseño 

 
1. Primero creamos un diseño nuevo seleccionando File -> New Design del menú. En el 

dialogo resultante, escribir un nombre para el diseño en el campo Database File Name, y 
hacer clic sobre el botón Browse para seleccionar un directorio en el que almacenar el nuevo 
diseño (generalmente en “Mis Documentos”). Una vez haya terminado, hacer clic en Ok 
para crear el nuevo diseño. Nuestro diseño nuevo se encontrará abierto en el espacio de 
trabajo. 

2. La ventana de diseño mostrará el contenido del diseño, que incluye una carpeta de 
documentos por defecto denominada Documents. Hacemos doble clic en el icono 
Documents para abrir la carpeta como una nueva pestaña en la ventana de diseño. Nos 
encontraremos con una carpeta vacía. 
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3. Podemos añadir un esquemático al diseño, almacenándolo en la carpeta Documents. 
Hacemos clic con el botón derecho dentro del panel Documents vacío en la ventana de 
diseño y seleccionamos New del menú emergente. 

4. El dialogo resultante mostrará una lista de tipos de documentos que se pueden crear. Si 
seleccionamos Show all document kinds mostraremos los documentos de todas las 
aplicaciones que soporten OLE. Seleccionamos Schematic Document y hacemos clic en 
OK. Una hoja de esquemático en blanco se creará en la carpeta del diseño actual. 

5. Escribimos un nombre para la hoja y pulsamos ENTER para guardar el nombre. 
6. Hacemos doble clic sobre el icono del esquemático para abrir la hoja en la ventana de diseño. 

Estamos listos ahora para comenzar el diseño de nuestro circuito. 
 

Protel 99 permite almacenar cualquier número de documentos en un diseño. Las 
carpetas son documentos especiales que contienen otros documentos o carpetas, esto nos 
permite organizar los documentos de forma jerárquica en la base de datos de diseño. 
Podemos soltar con el ratón documentos y carpetas en la ventana de diseño y en el árbol de 
navegación para cambiar la estructura de la base de datos del diseño. 

 
Así como documentos generados con Protel, Protel 99 permite almacenar cualquier tipo 

de documento en la base de datos de diseño. Además también permite convertir documentos de 
otros paquetes de CAD como OrCAD o PsPice. Cuando una carpeta se encuentra activa, 
hacemos clic con el botón derecho del ratón en la ventana de diseño y seleccionamos Import 
para introducir un documento en el diseño. 

 
3. Captura de diseños. 

 
3.1.- Trabajo con Múltiples hojas de esquemáticos 

 
1. Abrir LCD Conroller.ddb que se encuentra en la carpeta c:\Archivos de programa\Design 

Explorer 99\Examples\. 
2. Hacer clic sobre el símbolo + cercano al nombre del diseño en el árbol de navegación para 

expandir la carpeta, y luego expandir la carpeta LCD Controller para ver su contenido. 
3. Hacer clic en el icono LCD Controller.prj para abrir el esquemático en la ventana de 

diseño. Esta es la hoja del esquemático de mayor nivel. Los rectángulos verdes se llaman 
“símbolos de hoja” y cada uno representa una sub-hoja del esquemático. 

4. Hacer clic en el botón de navegación de la hoja sobre la barra de herramientas del esquema 
principal. El cursor cambia a una cruz. 

5. Hacer clic en un símbolo de hoja. Protel 99 nos dirige a la sub-hoja apropiada. 
6. Hacer clic con el botón derecho o pulsar ESC para salir del modo de navegación. 

 
El árbol de navegación (hacer clic en la pestaña del explorador encima del Panel del 

gestor de diseño para ver el árbol) muestra una vista jerárquica del proyecto esquemático. 
Protel99 permite un número ilimitado de hojas y de niveles de jerarquía. 

 
El entorno jerárquico nos permite adoptar un método modular hacia arriba o hacia abajo 

en el diseño. Se puede crear el esquemático de alto nivel primero, usando símbolos de hoja para 
representar módulos esquemáticos subhoja, luego seleccionamos Tools -> Create Sheet From 
Symbols para generar de forma automática plantillas de hojas de menor nivel en la jerarquía. De 
forma alternativa podemos crear primero los módulos subhojas y seleccionar Tools -> Create 
Symbol From Sheet para generar un símbolo de hoja que represente el esquemático. 
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3.2.- Comprobación de la integridad eléctrica del esquemático 
 

1. Abrir LCD 
Controller.ddb que se 
encuentra en la carpeta 
C:\Archivos de 

programa\Design 
Explorer 99\Examples. 

2. Hacer clic en el símbolo 
+ cerca del nombre de 
diseño en el árbol de 
navegación para 
expandir la carpeta, y 
luego expandir la carpeta 
LCD Controller para 
ver su contenido. Hacer 

clic en el icono LCD Controller.prj para abrir el esquemático en la ventana de diseño. 
 
3. Para encontrar problemas en el diseño se realiza el chequeo de reglas eléctricas (ERC). 

Seleccionar Tools -> ERC. El ERC incluye opciones para comprobar la mayoría de los 
errores de diseño. También, la pestaña Rule Matrix del dialogo de ERC nos permite 
fijar condiciones eléctricas invalidas, como una patilla de salida conectada a otra patilla 
de salida. 

4. Dejar todas las opciones por defecto en el dialogo Setup Electrical Rules Check y 
hacer clic en OK para ejecutar el ERC. La ejecución del ERC crea un informe LCD 
Controller.ERC que se muestra de forma automática. 

5. En el informe podemos observar varios avisos en cuanto a patillas de E/S conectadas a 
patillas de salida, una condición fijada en la Matriz de Reglas. Usar el ratón para resaltar 
uno de los números de patilla en el informe, por ejemplo “U6-C2” (resaltar solo el 
designador de componte y texto del número de patilla). 

6. Hacer clic en el botón Crossprobe de la barra de botones principal. La hoja de 
esquemático relevante se activará con el componente resaltado centrado en la pantalla. 
Esto nos permite navegar fácilmente por las áreas problemáticas de nuestro 
esquemático, independientemente de que hoja contenga el error. 

 
3.3.- Creación de una lista de materiales para el diseño. 

 
1. Abrir el diseño 4 Port Serial Interface.ddb 

que se encuentra en la carpeta C:\Archivos de 
programa\Design Explorer 99\Examples. 

2. Hacer clic en el símbolo + próximo al nombre 
de diseño en el árbol de navegación, y luego 
expandir la carpeta 4 Port Serial Interface 
para ver su contenido. Hacer clic en el icono 4 
Port Serial Interface.prj para abrir el 
esquemático en la ventana de diseño. 

3. Seleccionar Reports -> Bill of Material de 
los menús del esquemático para arrancar el 
asistente de Lista de Materiales (BOM 
Wizard). Este asistente nos permite realizar 
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todos los pasos necesarios para generar una Lista de Materiales en formato texto, o como una 
hoja de cálculo compatible con Microsoft Excel. 

4. Avanzar a través del asistente de Lista de Materiales dejando todas las opciones en sus 
valores por defecto. Cuando el asistente termine, se habrá generado una lista de materiales 
para el proyecto como una hoja de cálculo compatible con Excel y mostrada con el editor 
integrado de Protel. 

 
 

3.4.- Inclusión de lógica programable en el diseño. 
 

1. Abrir LCD Driver.ddb que se encuentra en la carpeta C:\Archivos de programa\Design 
Explorer 99\Examples. 

2. Hacer clic en el símbolo + próximo al nombre de diseño en el árbol de navegación, y 
luego expandir la carpeta LCD Driver para ver su contenido. Hacer clic en el icono 
LCD.sch para abrir el esquemático en la ventana de diseño. El esquemático muestra el 
circuito funcional para un driver LCD implementado en un dispositivo G22V10. 

3. Seleccionar PLD -> Configure del menú del esquemático. El diálogo resultante muestra 
varias opciones del compilador y los ficheros de salida disponibles que se pueden 
generar. Dejar todas las opciones por defecto. Observar que el dispositivo G22V10 ha 
sido seleccionado como dispositivo a emplear. Hacer clic en OK para cerrar el diálogo. 

4. Para crear los ficheros necesarios en la programación del dispositivo, seleccionar PLD -
> Compile del menú de esquemático. 

5. Cuando el compilador haya finalizado, asegurarse que la opción View Files esta 
marcada en la caja de mensajes del compilador de PLD, luego hacer clic en Close para 
cerrar el dialogo y ver los ficheros de salida del compilador. 

 
Cuando se diseña un circuito usando los símbolos lógicos de las librerías de símbolos de 

Protel (que se encuentran en c:\Archivos de Programa\Design Explorer 
99\Library\Sch\PLD.ddb), se puede compilar el circuito directamente a partir del esquemático 
para producir un fichero en formato estándar JEDEC para descargar directamente en  el 
programador de dispositivos. 

 
También podemos usar el editor de texto integrado para crear fichero PLD directamente, 

en el Lenguaje de descripción de Hardware CUPL independiente del dispositivo, usando tablas 
de verdad tradicionales, maquinas de estado y ecuaciones boleanas. 

 
4.- Diseño de PCBs 

 
4.1- Conceptos básicos de fabricación de PCBs. 

 
Los paquetes de diseño de PCBs están compuestos por tres herramientas, el editor de 

componentes, el editor de layout y el postprocesador, que se encarga de la impresión. Cuando 
comenzamos el diseño de una nueva placa de circuito impreso, las medidas viene impuestas por 
restricciones de diseño, normalmente se trabaja con medidas inglesas, se emplea la milésima de 
pulgada, donde una pulgada son 2.45 cm. 

 
El trazado de las pistas de cobre se realizaba antiguamente empleando una hoja 

cuadriculada transparente de guía, sobre la que se colocaban una cinta opaca con la que se 
trazaban las pistas. Se trabajaba al doble del tamaño natural y luego se reducía por medios 
fotográficos, de esta forma cualquier error cometido en el trazado quedaba también reducido. 
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Se hizo práctica común usar múltiples hojas transparentes para las diferentes capas del 

trabajo, la máscara de soldadura donde aparecen las referencias de los componentes, 
normalmente en blanco, un patrón de taladrado para la posterior fabricación, el rutado de las 
pistas de cobre de una o más capas, normalmente en pares. Este método de trabajo hacia difíciles 
posteriores correcciones al diseño. Hoy día debido a la profusión de ordenadores personales 
potentes existen herramientas para facilitarnos el trabajo.  

 
La librería de componentes es la parte más importante del programa de diseño. Un 

programa de captura de esquemáticos con herramientas de diseño de PCB tiene enlaces que 
definen como un símbolo del esquemático se relaciona con un símbolo de PCB. El procesado del 
esquemático genera un fichero de netlist para el programa de rutado. Hay que prestar atención a 
como se relacionan la numeración de las patillas del símbolo en el esquemático y en el 
encapsulado del componente. E, B y C de un transistor no siempre coinciden con 1, 2 y 3 del 
componente físico. 

 
Sin embargo, siempre podemos diseñar encapsulados especiales. La librería de 

componentes puede ser tan sencilla o complicada como necesitemos. Toda la información de 
lista de materiales se puede almacenar con cada componente si creamos un PCB a partir de un 
esquemático. La mayoría de los diseños tienen un tamaño de PCB predefinido. Comenzamos 
definiendo las dimensiones exteriores de la placa y los agujeros de montaje necesarios. Resulta 
útil imprimir un dibujo de la placa para recortarla y colocarla en su emplazamiento para 
comprobar que se ha tomado la medida correctamente, así como la posición de los agujeros de 
montaje. 

 
Luego, leemos el netlist creado por el software de captura de esquemático. Este proceso 

lee componentes de las librerías y los coloca uno encima de otros en el origen del dibujo. El 
segundo paso importante es la correcta colocación de los componentes. Cuando se mueve un 
componente a una zona libre de la placa, observamos una líneas que lo unen a otros 
componentes, estas líneas nos sirven para encontrar la disposición más adecuada con respecto a 
los demás componentes. Colocar los condensadores de desacoplo cerca del extremos de los C.I. 
para mantener la longitud de las pistas lo más cortas posible. 

 
Mantener los componentes de entrada y de realimentación tan cerca como sea posible de 

la entrada de los amplificadores. Los componentes de la circuitería analógica deben permanecer 
separados de la circuitería digital. Una vez que se hayan colocado los componentes se puede 
imprimir una prueba para comprobar la colocación de los conectores y zonas donde los 
componentes puedan causar problemas. La tercera fase consiste en colocar las pistas de cobre 
que unen los componentes, esta fase puede ser automática o manual. 

 
Por último la cuarta fase es la impresión mediante una impresora de alta resolución del 

diseño final en un papel especial que sea transparente a la luz actínica.  
 

4.2.- Comienzo del ruteo de la placa de circuito impreso 
 

1. Abrir el diseño 4 Port Serial Interface.ddb que se encuentra en la carpeta C:\Archivos 
de programa\Design Explorer 99\Examples. 

2. Hacer clic en el símbolo + próximo al nombre de diseño en el árbol de navegación, y 
luego expandir la carpeta 4 Port Serial Interface para ver su contenido. El diseño ya 
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contiene una PCB terminada, pero nosotros empezaremos una nueva placa para el 
diseño. 

3. Seleccionar File -> New del menú. En la pestaña Wizards del dialogo de Nuevo 
Documento seleccionar Printed Circuit Board Wizard y luego hacer clic en OK. 

4. Avanzar a través del asistente y realizar las siguiente selecciones: IBM XT bus 
format(formato IBM XT); XT Short Bus(Bus corto); Two Layer – Plated Through hole 
(Placa de dos caras con taladro metalizado)y No power/ground planes(No colocar planos 
de masa); Through hole Vias only(Interconexión a través de placa solo); Through hole 
Components (Componentes que atraviesan la placa) y Two tracs between pads(Dos 
pistas entre pads); default track(ancho de pista por defecto), via y hole. Hacer clic en el 
botón Finish para crear la nueva placa. 

5. Antes de transferir la información 
del esquemático debemos cargar las 
librerías de distribución de patillas 
(footprints) de los componentes 
adecuadas, las cuales han sido 
almacenadas con el diseño de 
ejemplo. Seleccionar Design -> 
Add/Remove Library del menú 
del PCB. En el dialogo de librerías 
navegar hasta 4 Port Serial 
Interface.ddb y seleccionarlo. 
Hacer clic en el botón Add para 
añadir la base de datos a la lista de 
librerías, luego hacer clic en OK 
para cerrar el diálogo. Esto hace 
disponible al editor de PCB todas las librerías de la base de datos. 

6. En el árbol de navegación, hacer clic en el icono 4 Port Serial Interface.prj para abrir 
el esquemático. 

7. Seleccionar Design -> Update PCB del menú del esquemático. El dialogo resultante 
listará todos los posibles documentos PCB a actualizar. Seleccionar el PCB que se acaba 
de crear de la lista y hacer clic en el botón Apply. 

8. En el dialogo Update Design, dejar todas las opciones en sus valores por defecto y 
hacer clic en el botón Execute, el sincronizador de diseños analizará el esquemático y 
los documentos PCB y determinará cualquier diferencia entre ellos. 

9. Debido a que esta es la primera vez que el esquemático se ha sincronizado con esta 
placa, se abrirá el dialogo Confirm Component Associations mostrando todos los 
componentes encontrados en la nueva PCB. Observar que el conector P1 del 
esquemático se ha emparejado con el conector de borde XT de la placa. Todos los 
demás componentes se han listado como no emparejados porque no se habían colocado 
todavía en la placa. Hacer clic en Apply para actualizar la PCB. 

10. Cuando el sincronizador haya terminado de actualizar el diseño, hacer clic en la pestaña 
de la nueva PCB para hacerla activa. Todos los componentes e información de 
conectividad del esquemático se ha transferido a la PCB y esta se encuentra lista para 
realizar el layout y rutado. 

 
El Asistente (Wizard) de placas de circuito impreso nos va a permitir escoger nuestra 

placa de unas 60 placas estándar de la industria, o crear una nueva disposición mecánica que 
podemos guardar como plantilla para uso futuro. El sincronizador de diseño se puede ejecutar en 
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cualquier momento durante el proceso de diseño para reflejar los cambios entre el esquemático y 
el PCB. 

 
4.3.- Modificación del ancho de las pistas de alimentación para que 
tengan un ancho mínimo. 

 
1. Abrir el diseño Z80 Microprocessor.ddb que se encuentra en la carpeta C:\Archivos de 

programa\Design Explorer 99\Examples. 
2. Hacer clic en el símbolo + próximo al nombre de diseño en el árbol de navegación, y 

luego expandir la carpeta Z80 Processor para ver su contenido. Hacer clic en el icono 
Z80 Processor board.pcb para abrir la placa en la ventana de diseño. 

3. Seleccionar Design -> Rules del menú de PCB y activar la pestaña Routing en el 
diálogo Design Rules. 

4. Hacer clic sobre Width Constraint en la lista Rule Classes para seleccionarlo. En la 
lista de reglas notamos que las líneas de alimentación para la placa tienen reglas 
especiales aplicada que fijan individualmente los anchos de pista. Podemos colocar 
múltiples reglas de diseño de la misma clase y aplicarlas a diferentes objetos fijando su 
ámbito de aplicación. Protel aplica reglas de forma jerárquica dependiendo de su ámbito. 
En este caso la regla de ancho fijada para líneas individuales sobrepasa la regla general 
de ancho de todas las pista de la placa que está fijada en 10 mil(10 milésimas de 
pulgada, 1 pulgada=2.54 cm). 

5. Hacer clic en el botón Run DRC para abrir el diálogo del comprobador de reglas de 
diseño (DRC), donde configuramos que reglas se van a incluir en el informe del DRC. 
Hacer clic en el botón Run DRC en este diálogo para generar un informe que liste todas 
las violaciones de reglas seleccionadas. 

 
El entorno de diseño de Protel está guiado por reglas. Podemos construir un conjunto de 

reglas de diseño coherentes que abarquen el rutado, la fabricación, el diseño de alta velocidad, la 
integridad de las señales digitales y más cosas. 

 
Las violaciones de las reglas de diseño se pueden ver directamente a medida que se 

trabaja, apareciendo resaltadas de forma inmediata. También, el rutado manual en Protel fuerza 
el cumplimiento de las reglas relevantes, como las restricciones de ancho, a medida que se rutea 
la placa, minimizando la posibilidad de errores. 
 
4.4.- Rutado manual de la placa. 

 
1. Abrir Board1.ddb que se encuentra en la carpeta C:\Archivos de programa\Design 

Explorer 99\Examples\PCB Auto-Routing. 
2. Hacer clic en el símbolo + próximo al nombre de diseño en el árbol de navegación, y 

luego expandir la carpeta Board 1 para ver su contenido. La carpeta contiene placas de 
PCB idénticas, una rutada y la otra no. Hacer clic en el icono Board1.pcb para abrir la 
placa no rutada en la ventana de diseño. 

3. El placa debe mostrar líneas de conexión entre las patillas de los componentes 
colocados. Si las líneas de conexión no están visibles, pulsar la tecla L para abrir el 
dialogo Document Options en la pestaña de capas (Layers) y asegurarse que la capa 
Connect está activa. Hacer clic en el botón OK para cerrar el diálogo. 

4. Posicionar el cursor sobre la placa y pulsar la tecla PGUP para ampliar la placa, centrada 
en la posición del cursor. Repetir esto hasta que los números de pin y los nombres de las 
líneas (nets) resulten visibles sobre las patillas. 
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5. Hacer clic en las pestañas de las capas Top (componentes) o Bottom (soldaduras) en la 
parte de debajo de la ventana de diseño de placa para seleccionar la capa. 

6. Pulsar la tecla P para mostrar el menú de colocación (Placement) y seleccionar Track. 
El cursor cambiará a una cruz. Posicionar el cursor sobre una patilla y hacer clic en el 
botón izquierdo para comenzar el rutado. 

7. Hacer clic para anclar cada segmento de pista a medida que se va rutando. Pulsar <- 
(BACKSPACE) para levantar el último segmento de pista que se haya colocado. Hacer 
clic con el botón derecho o pulsar ESC para terminar de colocar la pista. 
Permaneceremos en el modo de colocación de pistas, permitiéndonos comenzar a 
colocar otra pista. Hacer clic con el botón derecho o pulsar ESC de nuevo para salir del 
modo de colocación de pistas. 

 
Protel incluye varias características de automatización para facilitar todo lo posible el 

rutado manual de la placa. Protel usa un algoritmo de conectividad que analiza continuamente el 
diseño a medida que se rutea, optimizando y ajustando las líneas de conexión a medida que se 
coloca cada pista. Esto nos permite rutar las conexiones a lo largo de cualquier camino, sin tener 
en cuenta la línea de conexión actual. Una rejilla eléctrica tiene preferencia sobre la rejilla snap, 
que se usa para la visualización, permitiéndonos rutar conexiones de componentes que no se 
ajusten a la rejilla. 

 
Protel incluye varios modos de colocación de pistas: en 45 grados, ortogonal, oblicuo o 

en arco. Pulsar MAYUS+BARRA ESPACIO durante la colocación para cambiar de modo. En 
cada modo, pulsar BARRA ESPACIO para cambiar entre los modos de ángulo de comienzo y de 
fin. Para cambiar de capa cuando se rutea, pulsar la tecla asterisco ‘*’ del teclado numérico para 
cambiar entre las capas de señales disponibles. Se insertará una via si es necesario. 

 
El modo de rutado “Evitar obstáculo” monitoriza de forma automática el rutado e impide 

la violación inadvertida de cualquier regla de diseño al colocar una pista en un objeto que no se 
encuentre en la misma net. El modo “Empujar obstáculo” permite mover pistas a medida que se 
rutea. Para cambiar los modos de rutado, seleccionar Tools -> Preferences del menú de PCB. En 
la pestaña Options del diálogo resultante, seleccionar una opción de la lista desplegable 
Interactive Routing Mode. 

 
4.5.- Rutado automático de toda la placa. 

 
1. Abrir Board1.ddb que se encuentra en la carpeta C:\Archivos de programa\Design 

Explorer 99\Examples\PCB Auto-Routing. 
2. Hacer clic en el símbolo + próximo al nombre de diseño en el árbol de navegación, y 

luego expandir la carpeta Board 1 para ver su contenido. La carpeta contiene placas de 
PCB idénticas, una rutada y la otra no. Hacer clic en el icono Board1.pcb para abrir la 
placa no rutada en la ventana de diseño. 

3. Posicionar el cursor sobre la placa y pulsar la tecla PGUP para ampliar la placa, centrada 
en la posición del cursor. Repetir esto hasta que los números de pin y los nombres de las 
líneas (nets) resulten visibles sobre las patillas. 

4. Para rutar automáticamente una net en particular, seleccionar Auto Route -> Net del 
menú de PCB. El cursor cambiará a una cruz. Hacer clic con el botón izquierdo del ratón 
sobre la net relevante y automáticamente se rutará la net entera. Continuar seleccionando 
otras nets a rutar, o hacer clic con el botón derecho o pulsar ESC para salir del modo de 
rutado automático. 
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5. Se puede rutar automáticamente una conexión sencilla en una net, todas las patillas 
(pads) de un componente en particular, o todas las conexiones dentro de un área definida 
repitiendo el paso 4 anterior y seleccionando el opción correspondiente (Connection, 
Component, Area) del menú Auto Route. 

6. Para rutar automáticamente la placa entera, seleccionar Auto Route -> All del menú 
PCB. 

 
5.- Gestión de componentes con Protel 99. 
 
5.1.- Almacenaje de librerías en Protel. 
 

En Protel 99 tanto las librerías de símbolos de esquemáticos como las de distribución de 
patillas de componentes se almacenan en bases de datos de diseño. Se puede almacenar cualquier 
número de librerías dentro de una única base de datos. 

 
Protel 99 incluye un conjunto de librerías de símbolos y de patillas bastante completo. 

Estas se pueden encontrar en la carpeta C:\Archivos de programa\Design Explorer 
99\Library\Sch (Para símbolos de esquemático) y en C:\Archivos de programa\Design Explorer 
99\Library\Pcb (Para distribución de patillas de componentes). 

 
Para usar los símbolos y componentes contenidos en las librerías en un esquemático o 

PCB no es necesario abrir las bases de datos de diseño correspondientes. Se debe, sin embargo, 
indicar al editor de esquemáticos o PCB los nombres de las bases de datos que contienen las 
librerías que queramos usar. 

 
1. Cuando un esquemático o diseño PCB se encuentra activo en la ventana de diseño, 

hacemos clic en la pestaña Browse sch o Browse PCB sobre el panel de navegación 
para activar el panel de visualización. 

2. Fijamos el modo a Libraries. Cualquier librería disponible se mostrara en la lista 
descriptiva. 

3. Para añadir una librería a la lista, hacer clic en el botón Add/Remove del panel de 
visualización. En el diálogo resultante podemos hojear las bases de datos de diseño. 
Seleccionar una base de datos y hacer clic en el botón Add para añadir a la lista de 
ficheros disponibles. Todas las librerías del tipo correspondiente contenidas en la base 
de datos estarán disponibles en nuestros documentos. Hacer clic en OK para cerrar el 
diálogo. 

 
Una vez cargadas las librerías en el esquemático o editor PCB, los símbolos o footprints 

que contengan se añadirán a nuestro diseño. 
 
Para editar el contenido de una librería, debemos abrir la base de datos que contenga la 

librería en el Explorador de Diseño. Si la librería se ha cargado en el editor de esquemático o 
PCB, podemos seleccionar un componente de la librería en la lista del panel descriptivo y hacer 
clic en el botón Edit para abrir la base de datos directamente para editarla. 
 
5.2.- Selección de símbolos estándar. 
 
1. Abrir cualquiera de los diseños de ejemplo que se encuentran en la carpeta C:\Archivos de 

programa\Design Explorer 99\Examples\. 
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2. Usar el símbolo + para expandir la carpeta de diseño y abrir cualquier esquemático haciendo 
clic sobre su icono de esquemático en el árbol de navegación. 

3. Seleccionar Tools -> Find Component de los menús del editor de esquemáticos. 
4. Escribir *80486* en el campo de texto By Library Reference, incluyendo los asteriscos. 
5. Deseleccionar la opción Find All Instances para parar la búsqueda tras encontrar la primera 

ocurrencia del componente. 
6. Hacer clic en Find Now para comenzar la búsqueda. 

 
Protel listará cualquier componente en el que coincida la descripción de búsqueda y las 

librerías en las que se encuentra. Podemos colocar entonces un componente directamente en el 
esquemático, editar el símbolo o cargar las librerías en la lista de librerías actuales para hojear 
los componentes que contiene. 

 
Podemos buscar componentes por referencia de librería o por sus campos descriptivos. 

Protel buscará en las librerías actualmente cargadas, en una carpeta del disco, o en todas las 
unidades (incluyendo unidades de red) cualquier referencia al componente. La cadena de 
búsqueda del componente puede incluir los símbolos * y ?, permitiéndonos tener en cuenta las 
convenciones de nombres de diferentes fabricantes. Protel mantiene un centro de desarrollo de 
nuevas librerías en www.protel.com, desde donde se pueden descargar las últimas versiones de 
las librerías. 
 
5.3.- Creación de nuevos símbolos para PCB. 
 
1. Abrir LCD Controller.ddb que se encuentra en la carpeta C:\Archivos de programa\Design 

Explorer 99\Examples. Hacer clic en el símbolo + cerca del nombre de diseño en el árbol de 
navegación para expandir la carpeta, y luego expandir la carpeta LCD Controller para ver su 
contenido. 

 
Los footprint se crean y se almacenan en documentos de librería de PCB, dentro de una base de 
datos de diseño. La librería de diseño suministrada con Protel se puede encontrar en las bases de 
datos de diseño de librería en la carpeta C:\Archivos de programa\Design Explorer 
99\Library\PCB\. Para realizar este ejemplo crearemos una nueva librería de footprint basada en 
los footprint de la placa LCD Controller. 
 
 
2. Hacer clic en el icono LCD Controller.ddb en el árbol de navegación para abrir el documento 

PCB en la ventana de diseño. 
3. Seleccionar Tools -> Make Library de los menús. El editor de librerías se abre y se crea una 

nueva librería LCD Controller.lib que contiene todos los footprint de nuestro diseño. 
4. Hacer clic en la pestaña Browse PCBLib encima del panel de navegación para activar el 

Panel de visualización y ver una lista de los componentes en esta librería. 
5. Para crear un componente nuevo en esta librería, seleccionar Tools -> New Component del 

menú del editor de librería PCB. Se ejecuta el asistente de componentes. 
 
El asistente nos guía a través del proceso de creación de un nuevo footprint, 

permitiéndonos escoger de varias tecnologías de encapsulado y fijar varias opciones y 
dimensiones. Cuando el asistente finaliza, el nuevo componente se añade a la librería actual listo 
para ser usado. 


